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ABSTRACT

The integration of robotics and automation techniques in sanitary landfill operations would
dramatically reduce construction workers' exposure to hazardous materials and improve
the productivity of landfill operations. The autonomous equipment would provide a
system where the productivity associated with waste spreading would be increased. Since
there are uncertain job-site conditions in landfill sites, the stability of the autonomous
compactor must be real-time protected. Another concern is the proper layout planning and
utilization of the landfill space because it is an important resource for the landfill company.
Productivity can be increased if the compactor can determine and apply the number of
passes correctly by measuring on-site compaction density. This paper describes a
software system developed to facilitate the generation of area-covering path plans of the
autonomous compactor for the spreading and compaction processes on rough surfaces, the
landfill space management associated with a proposed sensing system, and the
recommended approach to determine the compaction density.

1. INTRODUCTION

Based on past experience throughout the United States and elsewhere in the world, land

disposals in the form of sanitary landfills have proved to be the most economical and

acceptable method for the disposal of solid waste . Though the majority of technical waste

management issues deal largely with chemical processes , techniques , and geotechnical

design , sanitary landfills require new construction engineering management skills as well.
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One of the major concerns with solid waste handling is the potential long-term health risks
faced by manual workers/operators from constant exposure to the toxic solid, liquid, and
gaseous by-products produced by the decomposing waste materials in the landfill site.
Another area of concern is the proper layout planning and utilization of space in jobsites.
Since the unused capacity of a landfill site is a resource, the landfill company will try to
minimize the unused portion. To improve the productivity of waste spreading and
compaction processes, it is important for the compactor operator to follow an efficient
motion pattern and know that adequate compaction has been attained. Therefore,
developing optimal motion planning and measuring on-site compaction density are key

issues to reduce the required compaction time.

Robotics and automated technologies offer a new approach to deal with the above
concerns. Developing autonomous equipment (i.e., remotely controlled and operated)
would dramatically reduce workers potential exposure to hazardous materials. At the same
time, autonomous equipment would increase productivity by using special sensing
equipment. The productivity of the landfill would be increased because of better space
management through optimal path planning. This unique ability to increase safety and
decrease voids in the landfill at a lower cost makes the application and development of
robotics and automated technologies highly desirable for landfill operations.

Automation of processes, such as the spreading and compaction of waste and cover
material in a landfill site, requires an efficient operation planning system to generate an
area-covering path that facilitates autonomous movement of compactors. Tserng et. al,

19952 studied and developed an automation system to assist in the design of landfill cells
and the generation of an area covering path for an autonomous compactor for smooth
surfaces. Typically, a given landfill site can be partitioned into cells using a probabilistic

model for waste generation. The configuration of the landfill site is partitioned into a

quadtree data structure by employing a recursive spatial decomposition technique. A

recursive sub-division of each cell into monominoes facilitates the system to automatically

deal with any deviation in the actual volume of waste. Within the monomino, the motion
path of the compactor can be made by several motion models including: Straight-Up,

Straight-Down, and Zig-Zag motion models3.

Since there are uncertain job-site conditions at landfill sites (i.e., changing profiles and
trough surfaces), the balance of the autonomous compactor must be real-time controlled.
In addition, the landfill should be maintained to ensure a smooth surface. This paper
describes a software system that deals with the rough surface. Furthermore, the
positioning system, space management, and measurement of waste density involved with

the developed software will be discussed.

2. PROBLEM STATEMENTS

When developing a motion planning system for autonomous landfill compactor in
rough surfaced terrain, the following problems may be encountered.
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• Rough Surfaces and Variable Volume of Waste Dumped from Truck
As shown in Figure 1, there are two principal methods used to spread and compact

waste in a working face: (1) unloading solid waste at the toe of the slope and spreading
and compacting the solid waste from the toe of a slope to the top of the slope, and (2)
unloading solid waste at the top of the slope and spreading the solid waste and

compacting from the top of the slope to the bottom of the slope4. Due to the
uncertainty of the landfill surface, the landfill surface information is incomplete for the
motion planning system during the autonomous waste compaction. If the autonomous
compactor does not realize the surface condition, the waste will not be homogeneously
distributed by the compactor (see Figure la). Also, if the compactor doesn't have an
appropriate path plan for spreading the waste, the landfill surface will become rougher
as more passes are made. Therefore, the waste spreading process is an important
factor in influencing the uncertainty of the landfill surface. Furthermore, because of
varying truck sizes and different types of waste material, the volume of waste dumped
per truck load will change. The truck load is measured only by weight; therefore, it is
hard to determine the volume of waste carried by a truck if it is not enough for one
complete pass, as depicted in Figure lb. This situation will make the surface more
difficult to control because the compactor cannot move waste to finish the complete

working slope.

Figure 1: Waste Spreading and Compaction Process on Rough Surfaces

• Space Management
Since unused landfill space is the real commodity for landfill companies, space

management must be optimized. Finally, solid waste operations are a dynamic process
where many pieces of equipment, crews, and robots move about. Unless properly
addressed, congestion and interference could seriously hamper production and possibly
waste landfill space. Proper space scheduling and management offers substantial
benefits in terms of expanding the life time of landfill site as well as avoiding the
congestion and conflict of multi-vehicle operations.

• Mapping System
The mapping and positioning technologies are the key issues for navigating the

autonomous compactor. The mapping system also assists in developing the space
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management system. For instance, the occupied space can be obtained by the real-time
update of the autonomous compactor's position.

• Methods for Measuring Waste Density
In conventional operation, the waste is assumed to be homogeneous in the landfill.

Therefore, the compactor uses the same number of passes across the landfill.
However, this is not an efficient method. Productivity can be increased if the
compactor can determine and apply the number of passes correctly by measuring on-
site compaction density.

3. RESEARCH METHODOLOGY

In response to the problems presented and discussed above, recommended
methodology and suggestions are presented below.

3.1 Sensing System to Understand Surface Conditions

Because of the inherent uncertainties in the landfill surface, the waste must be
homogeneously distributed by the compactor. If not, it will become increasingly difficult
to handle the dynamic stability of the autonomous compactor on rough surfaces. Figure 2
shows the motion planning software system used for this research and the proposed
sensing system for understanding the surface condition. If the compactor has two base-
inclination converters (see the right-upper window of Figure 2) to detect the orientation
information of the compactor, the autonomous compactor can obtain the orientation angles

(a, (3) of the compactor. In addition, the high-precision compass provides the rotation

information of the compactor (see the right-upper window of Figure 2). The Global
Positioning System (GPS) provides the compactor's location in the landfill configuration.
By combining the location coordinates, rotation angle, and the base-inclination angles of the
compactor, the surface condition of the four wheels can be presented using the
transformation techniques.

Based on the sensing system proposed above, the compactor's stability can be
protected by a safe range of base-inclination angles that can be calculated exactly from a

mathematical model 5. Referring from the exact range of safe base-inclination angles, users
can input their designed safe range by selecting Base-Inclination Angle item from the
Sensor menu. In this automation system, there are two stage of motion approach: (1)
Autonomous-Navigation Stage and (2) Joystick-Control Stage. When the base-inclination
angle is inside the safe range, the autonomous compactor is in the Autonomous-Navigation
Stage. In this stage, the compactor operates the waste spreading and compacting processes
automatically. When the compactor comes close to a stability-loss position (i.e., big holes,
sharp slope, or instant obstacles,... etc.), a warning signal will sound and the system

switches to the Joystick-Control Stage. In this stage, the remote operator can navigate the
compactor to deal with the problem by joystick via vision-aided monitor.
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After the computer moves to the top of the slope, the whole surface condition of the
strip can be approximated. As the compactor crosses the working face, the sensory
feedback for each position can be stored into a specific data structure which will be
described in the next section. Consequently, the surface conditions of the entire working
face can be understood.

Figure 2: Sensing System for Autonomous Landfill Compaction

3.2 Partition Working Surface by Spatial Decomposition Technique

In spatially decomposing a landfill site, the quadtree and B-tree data structure are
employed together to partition the landfill into small working areas. As shown in Figure 4,
the entire data structure has three major levels: cell level, monomino level, and strip level.
In cell level, the landfill site can be partitioned into cells using a quadtree structure. The
tiling of a cell is performed by monominoes whose dimensions depend on the
characteristics of the compactor and the size of the landfill site. The waste compaction
within one monomino can be completed by several circles of a motion model. Using B-tree
structure, one circle of a motion model (e.g., Zig-Zag model, see Figure 3) can be divided
into several strips and sections by the time elapse of the kinematic GPS system.
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Consequently, the surface information of each section can be restored into every leaf of the
entire data structure, and the surfaced terrain of working places can be obtained.

section °
0

1 I

stnp

Compactor ^^

Figure 3: Partition of Landfill Side

909090986
Figure 4: Data Structure of Landfill

3.3 Motion Strategy to Deal with Various Volume of Waste

Based on previous strip surface information along the slope, the compactor will move
the waste into the sections containing the least waste (Figure 5a). To deal with the varying
volume of waste dumped from a truck, the compactor can spreading the waste into the
empty sections in the next circle of spreaded waste (Figure 5b). These improvements to
the waste spreading process would make the landfill surface smoother. Following this, the
surface would always be maintained to minimize the surface uncertainty.

Spread Waste --

Compacted Waste

Empty Section

Figure 5: Recommended Motion Strategy for Spreading Waste
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3.4 GPS System to Success Motion Planning and Space Management

Another important function of the mapping and navigation system is controlling the
compactor's movement throughout the landfill. Knowing the compactor's location is
essential for the remote guidance of the landfill compactor. By placing landfill coordinates
on a computerized grid network, it will be possible to guide the compactor to desired
coordinates along a designated path. This system can save time, operator input, and help
in raising productivity. Global Positioning Systems (GPS) are space-based radio
positioning systems that provide 24 hour three-dimensional position, velocity, and time

information to suitably equipped users anywhere on or near the surface of the Earth6.

Ideally, the GPS antenna can be installed on the compactor. By using the real-time and
kinematics GPS system, the location of the compactor can be determined with great
precision. Simultaneously, the motion of compactor can be displayed on the computer
screen by transferring the location information to the computer. The whole structure of
this mapping system is shown in Figure 6. Based on the integration of GPS and the
specific data structure of Section 3.2, the capacity information of every section can be real-
time presented in 3-D configuration to assist in space management (see the zoom window
of Figure 6). In addition, the autonomous compactor can locate the proper working place
to compact waste by a recursive traversal method along the data tree (Figure 4).

Side View of
Landfill Site

3-D Software System

Control Room

- Using Real-Time and
Kinematic GPS to map the
position of compactors into the
configuration of landfill site.

Figure 6: Kinematic GPS and Landfill Space Management Systems
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3.5 Method to Determine Number of Passes

It is important for the compactor operator to know that adequate compaction has been
attained. By determining on-site compaction density, the number of passes can be
optimized and spurious passes avoided. Because the waste is not homogeneous,
determining the target density is difficult. However, an alternative approach that works
effectively is to measure the change in the z-coordinate from the angle of base-inclination
converters or by the GPS system. If the z-coordinate stays relatively constant as the
compactor moves back and forth along the slope, then adequate compaction has been
achieved and the compactor should move to the next work place.

4. SYSTEM IMPLEMENTATION AND DESCRIPTIONS

The 3-D animated simulation software system for autonomous landfill compaction is

implemented by using the PHIGS' graphical industry library and MOTIF toolkit library
with C-program linking. PHIGS provides the necessary environment of a X-window
system for hierarchical graphic models that allow an application programmer to describe a
graphic model without having to deal with the hardware details for producing the model on

a display device. MOTIF8 is based on the X Toolkit Intrinsics (Xt) of the X-window
system and offers functions to produce user-friendly interfacing objects such as windows,

menus and icons.

This motion planning system not only assists in compaction process planning, but

supports geometric design of landfill cells and landfill space management. During the input
stage, the configuration of the landfill site can be created using any commercial CAD
modeling package that provides ASM graphical format. It can be loaded by selecting the

Open option under the File menu as shown in Figure 7. After obtaining the input

pertaining to the landfill design and environmental information in the Control Panel

window, the landfill site can be partitioned into cells and monominoes using the recursive

decomposition algorithm3 by selecting the Cell and Monomino items from the Analysis

menu.

Multiple-views of the landfill site can be tiled together by varying the orientation of the

view reference planes for the tiled windows. The example screen shown in Figure 7
depicts a plan-view, an elevation, a front-view, and an isometric view of the landfill site at

the same time. Under the View menu, the Zoom-In, Zoom-Out, Pan-Around, and Pan-

Over functions can be selected to zoom, rotate, and translate the entire 3-D model into the
desired view during the animated simulation. Right-side windows present the values for
compass, GPS system, and base-inclination angles. In addition, two windows are designed
to zoom close to the side and front view of the compactor in order to monitor the details of

the waste compaction process.
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By selecting the Simulation menu, the motion path and cover surfaced terrain of the
compactor's motion within cells and monominos will be presented in 3-D animation. As
the compactor compacts the waste along the slope, the number of passes are determined
by the difference of values of z coordinates between passes. In addition, the autonomous
compactor will traverse the quadtree and B-tree data structure to locate the proper working

places for the efficient space management.

Figure 7: Multi-View Window of Animated Simulation System

5. CONCLUSION

In this paper, the critical ideas necessary for developing autonomous methods for
landfill compaction are presented and discussed. The proposed methodology addresses
two concerns of landfill managers: (1) manual operators a safety risks and (2) optimum
management of precious landfill space. Using the ideas presented, a 3-D animated
simulation software system was developed and presented. In the future, this research
could be expanded to develop a motion planning system for multi-vehicle landfill operation
including the relative motions of trucks, compactor, and crawler-tractors.
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